第十二章 好書推薦區---(Flash + ColdFusion)

13-1. 系統規劃與架構

(1). 本章目的：

· 現在很多網站都有提供聊天室，只要網友在該網站點選訂閱功能，並且輸入個人的email之後，就可以定時收到該網站所寄出的電子報。

· 本章的目的就是提供網友訂閱電子報的輸入系統，包括訂閱電子報的訂閱主畫面、修改個人email及取消訂閱網頁

13-2. 建立ColdFusion 元件 (CFC)在Dreamweaver MX

Creating the CFC file for the web service
The first thing we need to do is create the actual CFC file that will contain all of the functions for our web service. Once we have created this file and coded the functions in it, we can access the functions directly from within Macromedia Flash MX through the Flash Remoting gateway built into ColdFusion MX.

To create the web service file for the application:

(A). 開啟 Dreamweaver MX.軟體 

(B). 開新檔案：檔案→開新檔案 
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(C). 在新增文件的視窗中

· 類別→動態網頁

· 動態網頁→ColdFusion 元件

· 完成後按下→建立
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(D). 建立後上方的面板上就會出現技援ColdFusion有關的指令
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(E). 我們所要寫的ColdFusionc標籤語法都必須寫在cfcomponent 標籤語法內 
[image: image4.png]<cfcomponent> [—
<cffunction name="myFunction' access="public' returntype="string">
<cfargument name="myArgument" type="string’ required="true">
<cfset myResult="foo">
<ofreturn nyResulty
</cffunction>

cfcomponent>





(F). 插入 cfset 標籤

· 選擇面板中的「CFML 基本」→ 「set」圖示
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(G). 在 cfset 的標籤打入並且設定一個變數的名稱
· 設定 DATASOURCENAME 等於 "Notes" 
· 輸入<cfset DATASOURCENAME = "Notes"> 
[image: image6.png]<cfcomponent>

string’>
true’>

<cffunction name="myFunction' access="public" returntype:
<cfargument name="myArgument" type="string' requires
<cfset myResult="foo">
<cfreturn myResult>

</cffunction>

88 </cfcomponent>





(2). Creating the addNote web service function
Our application will perform a few basic operations which we'll create code functions for, including: adding a new note, editing an existing note, deleting an existing note, retrieving a list of all the available notes, and retrieving a single note to view. These five different aspects of the application will each need a function in the web service to manipulate the data from the database. We'll use the default function from the ColdFusion component template as the starting point for our first function to add a new note.

Note: For many of the ColdFusion tags that we'll be adding, we'll use the Tag Chooser (Insert > Tag or Ctrl + E) to select the tag. You can leave the Tag Chooser open while you edit the code if you wish.

開始建立一個加入資料的函數

(A). Modify the default function by selecting the cffunction tag. This is achieved by clicking anywhere in the opening tag and selecting Attributes from the Properties panel. The tag's Attributes dialog will appear with the attributes from the generic tag. 
(B). 在cffunction 標籤內按滑鼠右鍵→選擇「編輯標籤」
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(C). 使用標籤編輯器
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· 名稱→addNote

· 存取→遠端

· 傳回類型→結構

(D). 在cfargument標籤內再按下滑鼠右鍵→選擇「編輯標籤」
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(E). 使用標籤編輯器
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· 名稱→note

· 類型→字串

· 必要→勾選

(F). 按下「Enter」將游標移到下一行

[image: image11.png]<cfcomponent>

<cfset DATASOURCENAME = “HNotes">

<cffunction access='remote’ name
<cfargument name="note" type:

addote” output="false" returntyps
string’ required="true" default:

<cfset myResult="foo">
<cfreturn myResult>
</cffunction>
88 </cfcomponent>





(G). 加入另一個cfargument 標籤：點選「插入」→「標籤」
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(H). 在標籤選擇程式中

CFML標籤→ColdFusion MX 元件→「cfargument」
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(I). 編輯「Cfargument」標籤
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· 名稱→title

· 類型→結構

· 必要→勾選

(J). 接下來要修改已存在的cfset 標籤

· 將cfset 標籤的原本變數名稱和變數值myResult="foo"改為 var rQuery = ""
(K). 按下「Enter」將游標移到下一行

[image: image15.png]<cfcomponent>
<cfset DATASOURCENAME = “HNotes">

<cffunction access="remote’ name="addNote' output='false" returntype="struct’>
<cfargument name="note' type="string' required="true" default='
<cfargument name="title" type="struct’ required="true' default="
<cfset var riuery = "">

<cfreturn myResult>
</cffunction>
</cfcompenent>





(L). 插入一個cfquery 標籤 
· 點選面板中的 CFML 基本 → cfquery 圖示
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(M). 使用標籤編輯器

· 查詢名稱→rQuery

· 資料來源→#DATASOURCENAME#
· 加入SQL 陳述式:
INSERT INTO Notes (title, noteData)
VALUES ('#arguments.title#','#arguments.note#') 
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(N). 將游標移到下一行，再加入另一個cfquery 標籤

[image: image18.png]¥ <cfcomponent>

&) <cfset DATASOURCENAME = "Notes'>
<cffunction access="remote’ name="addNote" outpu
<cfargument name="note" type="string’ required=
<cfargument name="title" type="struct’ require
<cfset var riuery >
<cfquery name="r{uery" datasource="#DATASOURCENAME#" >
INSERT INTO Notes (title, noteData) VALUES C #arguments. title¥,’ #arguments.noted )
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alse’ returntyps
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</cffunction>
I6 </cfcomponent>




(O). 使用標籤編輯器

· 查詢名稱→rQuery

· 資料來源→#DATASOURCENAME#
· 加入SQL 陳述式:
Select @@identity AS newId 
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[image: image20.png]<cicomponent>

Bl <cfset DATASOURCENAME = "Hotes">

struct">

alse’ returntyps
rue” default="
true' defaul

<cffunction access="remote’ name="addNote" outpu
<cfargument name="note" type="string’ required=
<cfargument name="title" type="struct’ require

<cfset var riuery = "">
<cfquery name="r{uery" datasource="#DATASOURCENAME#" >

INSERT INTO Notes (title, noteData) VALUES C #arguments. title¥,’ #arguments.noted )
</ciquery>

<cfquery name="r{uery" datasource="#DATASOURCENAME#" >

£l Select @Bidentity AS newld

</ciquery>

<cfreturn myResult>
</cffunction>
] </cfconponent>





1. 最後加入 cfreturn 標籤 that already exists to return the note ID that we just added to the database. Remove myResult from the cfreturn tag and replace it with getNote(rQuery.newId).

[image: image21.png]¥ <cfcomponent>

Bl <cfset DATASOURCENAME = "Hotes">

<cffunction access='remote’ name="addNote' output="false" returntyp:
<cfargument name="note' type="string' required="true" default='
<cfargument name="title" type="struct" required="true" default="">
<cfset var riuery >

<cfquery name="r{uery" datasource="#DATASOURCENAME#" >
INSERT INTO Notes (title, noteData) VALUES C #arguments. title¥,’ #arguments.noted )
</ciquery>
¥ <cfquery name="r{uery’ datasource="#DATASOURCENAMER" >
£l Select @Bidentity AS newld

<cfreturn getNote(rQuery. newld):

<cfreturn myResult>
</cffunction>
] </cfconponent>




(3). Creating the updateNote web service function
The next function we'll create is the updateNote function, which will update an existing note in the database.

開始建立更新資料的函數

1. 將游標移到下一行
2. 使用標籤選擇程式加入一個新的 cffunction 標籤在新的一行

CFML標籤→ColdFusion MX 元件→「cffunction」
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3. 編輯「Cffunction」
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名稱→updateNote

存取→遠端

傳回類型→結構

4. Create a blank link between the cffunction opening and closing tags. 

5. 使用標籤選擇程式加入一個新的cfargument標籤

CFML標籤→ColdFusion MX 元件→「cfargument」 
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6. 加入第一個cfargument 標籤，再使用標籤編輯器設定
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名稱→id

類型→數值

必要→勾選

7. 加入另一個 cfargument 標籤的設定
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名稱→note

類型→字串

必要→勾選

8. 加入第三個cfargument 標籤的設定 
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名稱→title

類型→字串

必要→勾選

9. 在下一行，加入一個 cfset 標籤and 建立一個變數 rQuery
打入 var rQuery = "". 
[image: image28.png]<cfreturn myResult>
</cffunction>
<cffunction access="remote’ name='updateNote’ outpu
<cfargument name="id" type="mumeric’ required="true" defaul
<cfargument name="note' type="string' required="true" default='
<cfargument name="title' type="string" required="true" defaul
<cfset var rQuery = "">

false’ returntype="struct'>
>

</cffunction>
</cfcomponent>




2. 插入一個cfquery 標籤 
點選面板中的 CFML 基本 → cfquery 圖示
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10. 使用標籤編輯器

查詢名稱→rQuery
資料來源→#DATASOURCENAME#
加入SQL 陳述式:
UPDATE Notes set noteData = '#arguments.note#', title = '#arguments.title#'
WHERE id = #arguments.id# 
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11. 最後加入一個cfreturn 標籤並且設定讓它返回getNote(arguments.id).

[image: image31.png]i <cireturn getNote(rluery. newld)>

16 <cfreturn myResult>
17 </cffunction>
18 <cffunction access="remote’ name="updateNote" ocutput="false' returntype="struct'>
19 <cfargument name="id" type="mumeric’ required="true" default="
20 <cfargument name="note' type="string’ required="true" defaul
2 <cfargument name="title" type="string’ required="true" default=
<cfset var riuery = "">

PE] <cfquery name="rQuery’ datasource="#DATASOURCENANER" >

PXY UPDATE Notes set noteData = *#arguments.note®’, title = Rarguments. titled’ WHERE
id = #arquments. id#

</ciquery>

<cfreturn getNote(argunents. id)>

p2ed </cfcomponent>




Creating the removeNote, getAllNotes, and getNote web service functions
Now we'll create the removeNote, getAllNotes, and getNote functions. We'll move through these last three functions more quickly—since adding them is very similar to the previous two functions we've just created.

開始建立移除資料、讀取全部的資料、讀取一筆資料的函數

1. 在加入資料的函數的後面，接著再使用標籤選擇程式加入一個新的 cffunction 標籤

CFML標籤→ColdFusion MX 元件→「cffunction」
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名稱→removeNote

存取→遠端

傳回類型→數值

[image: image34.png]<cfreturn myResult>
</cffunction>
<cffunction access="remote’ name="updatelote’ ocutput="false' returntyp
<cfargument name="id" type="mumeric’ required="true" default="">
<cfargument name="note' type="string’ required="true" defaul
<cfargument name="title" type="string" required="true" default="
<cfset var r{uery = "">

<cfquery name="r{uery" datasource="#DATASOURCENAME#" >

UPDATE Notes set noteData = *#arguments.note®’, title =’ ¥arguments. title® WHERE

id = #arquments. id#

</ciquery>

<cfreturn getNote(argunents. id)>

struct">

<cffunction acces:
</cffunction>

remote” name='removeNote” output="false" returntype="numeric'>

</cfcompenent>




2. 接著下一行建立一個新的cfargument 標籤 
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名稱→id

類型→數值

必要→勾選
3. 再下一行建立新的 cfquery 標籤 
點選面板中的 CFML 基本 → cfquery 圖示
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4. 使用標籤編輯器
資料來源→#DATASOURCENAME#
加入SQL 陳述式:
DELETE FROM Notes where id = #arguments.id#  
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5. 加入一個新的cfreturn 標籤並且讓它返回arguments.id.
[image: image39.png]<cffunction access="remote” name="removelote” output="false" returntype="mmeric">
<cfargument name="id" type="rumeric’ required="true" default="">

<cfquery name="" datasource="#DATASOURCENAME#" >

DELETE FRON Notes where id = #armuments. id#

</ciquery>

<cfreturn arguments. id>

</cffunction>
</cfcomponent>




6. 接著「移除資料的函數」後面，建立 cffunction 標籤 
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名稱→getAllNotes

存取→遠端

傳回類型→查詢

7. 在getAllNotes cffunction 開始和結束標籤中加入cfset 標籤 並且加入變數rQuery  
打入 var rQuery = "". 
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<cfreturn arguments. id>
</cffunction>

<cffunction access="remote” name="getAllNotes" outpu

Kcfset var riuery f

</cffunction>
</cfcompenent>

false" returntype="query">





8. 跳到下一行，建立新的 cfquery 標籤 
點選面板中的 CFML 基本 → cfquery 圖示
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9. 使用標籤編輯器
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查詢名稱→rQuery
資料來源→#DATASOURCENAME#
加入SQL 陳述式:
SELECT * from Notes
10. 跳到下一行，建立一個新的 cfreturn 標籤 並且設定它返回 rQuery
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11. 接著「讀取全部資料函數」之後， 建立一個新的 cffunction 標籤 
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名稱→getNote

存取→遠端

傳回類型→數值
12. 跳到下一行，建立一個新的cfargument 標籤

[image: image46.png]EFEEHS - Clargument

Chargunent - —fft

£

B [miE
THERE
BTEH

R





名稱→id

類型→數值

必要→勾選
13. 跳到下一行加入cfset 標籤，設定一個變數 rQuery
打入 var rQuery = "" 
[image: image47.png]<cffunction access='remote’ name='getlote’ output="false’ returntype="struct'>
<cfargument name="id" type="rumeric’ required="true" default="">

<cfset var riuery [~

</cffunction>
</cfcomponent>





14. 跳到下一行，加入一個cfset 標籤 and create a new structure called noteStruct 
打入var noteStruct = StructNew()
 [image: image48.png]<cffunction access='remote’ name='getlote’ output="false’ returntype="struct'>
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15. 跳到下一行建立一個新的 cfquery 標籤 
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查詢名稱→rQuery
資料來源→#DATASOURCENAME#
加入SQL 陳述式:
SELECT * FROM Notes WHERE id = #arguments.id#
16. Now we'll loop through the query we just ran against the database, looking for the note that was requested from Macromedia Flash and assigning its data to the noteStruct structure we created. After the closing tag of the cfquery, 建立一個新的 cfloop 標籤：「插入」→「CFML流程」→「cfloop」[image: image50.png]RF BRI 2T | Fete | BIE | R % HhY | FUC 1A 1878 | Serpt| CFML 7 | CFML 52 | CPML R | EME |
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17. 選擇 Query loop from the loop type pull down and type rQuery as the query name to loop through. We'll be looping through the entire query, so we don't have to worry about setting a start or end row. 
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迴圈類型→queryloop

查詢名稱→rQuery

18. 加入cfloop 標籤後, set the following three variables in the noteStruct structure using the cfset tag:
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<offunction access="remote’ name='getlote’ output="false’ returntype="struct'>
<cfargument name="id" type="mumeric’ required="true" default="">

<cfset var r{uery = "">

<cfset var noteStruct = Structhes()>

<cfquery name="r{uery" datasource="#DATASOURCENAME#" >

SELECT * FROM Notes WHERE id = #arguments. id#

</ciquery>

<cfloop query="rluery">
cfset noteStruct. id = id />
cfset noteStruct. title = title /> -
cfset noteStruct.noteData = noteData />
</cfloop>

</cffunction>





<cfset noteStruct.id = id />
<cfset noteStruct.title = title />
<cfset noteStruct.noteData = noteData />
19. 在結束 cfloop 標籤之後，建立一個新的 cfreturn 標籤and have it return the entire structure we create, noteStruct.
[image: image54.png]45 <cffunction access="remote’ name="getNote' ocutput="false' returntype="struct'>
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55 <cfset noteStruct.noteData = noteData />
56 </cfloop>
7 <cfreturn noteStruct>
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13-3. 建立書籍查詢區畫面和設定Flash元件在Flash MX

1. 在 Macromedia Flash MX中打開隨書附上的光碟裡的檔案 noteboard_tutorial.fla[image: image55.png]
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3. 在左側的組件面板中拖曳一個 List Box 到場景中
4. 點選組件後，按下滑鼠右鍵選擇→屬性
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5. 點選擇 Message Box 圖層的第一影格
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6. 在組件面板中選擇→Flash UI Components Set 2 
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7. 在左側的組件面板中拖曳一個 MessageBox 到場景中
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8. 設定Message Box屬性，實體名稱為mBox. 
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9. 點選擇 Add/View/Edit 圖層的第一影格
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10. 在組件面板中選擇→Flash UI Components Set 2
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11. 在左側的組件面板中拖曳一個 IconButton到場景中[image: image65.png]IcanButton
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12. 在屬性面板中設定IconButton: 的屬性
實體名稱→viewButton
Label→瀏覽
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13. 在左側的組件面板中拖曳第二個 IconButton到場景中，並且設定屬性
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賽體名稱→editButton
 Label→修改/刪除
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14. 在左側的組件面板中拖曳第三個 IconButton到場景中，並且設定屬性
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15. 點選Submit/Delete 圖層的第20關鍵影格
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16. 在左側的組件面板中拖曳一個 IconButton到場景中，並且設定屬性

[image: image72.png]3

g

[





實體名稱→editDeleteButton
Label: 刪除
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17. 在左側的組件面板中拖曳另一個 IconButton到場景中，並且設定屬性
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實體名稱→editSubmitButton 
Label: 修改
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18. 點選Submit/Delete 圖層的第30關鍵影格
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19. 在左側的組件面板中拖曳另一個 IconButton到場景中，並且設定屬性
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實體名稱→ submitButton 
Label: Submit Note
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20. 點選TextFields 圖層的第10格關鍵影格，在這要加入三個文字欄位分別是標題、內容、狀態
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21. 選擇文字工具
[image: image80.png]



22. 在左側的組件面板中拖曳第一個 text field到場景中，並且設定屬性
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23. 在左側的組件面板中拖曳第二個 text field到場景中，並且設定屬性
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24. 在左側的組件面板中拖曳第三個 text field到場景中，並且設定屬性
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25. 在左側的組件面板中拖曳一個 ScrolBotton到場景中，並且設定屬性
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26. 儲存檔案

13-4. 寫入Flash的ActionScript在Flash MX
The first thing we need to do is create a few functions that will serve as some of the basic utilities in the application (such as clearing the text field in the user interface).

To create the utility functions for the application:
1. Open the Actions Panel (Window > Actions or F9). Make sure the Actions Panel is in Expert Mode by selecting Expert Mode from the panel menu in the upper right-hand corner or by pressing Ctrl-Shift-E while the Actions Panel is selected. Expert Mode will allow us to type ActionScript directly into the Actions Panel. 

2. 點選Actions 圖層的第一格關鍵影格，再開啟動作面板 
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3. 在第一行，加入Flash Remoting 的NetServices 指令
#include "NetServices.as"
#include "NetDebug.as"
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Note: 這些 AS 檔案都是Flash Remoting 的元件， NetDebug.as 檔案 is used only during authoring to debug network connection related problems during development. Once the application is complete, the NetDeBug.as include can be removed to reduce the SWF file size. 

4. Next we'll write some code to perform some of the basic functions of the application. The first function will sync the title and note fields with the selected note from the list box. Add the following code starting on line 4:
當我們項目選單中選擇一個項目時，標題文字和內容欄位文字會同時改變
syncFields = function()
{
  var data = lb.getSelectedItem().data;
  noteField.text = data.noteData;
  titleField.text = data.title;
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The first line in the function assigns all the data from the item selected in our list box (in this case, 
第一行是將list box連結選擇項目的資料

the note content and the note title) to a variable called data. The next two lines set the text in the
下二行是依選項目再讓標題文字欄位及內容文字欄位連結相同資料

 note and title text fields to the corresponding data that was retrieved from the database for the note. 

5. The next function we'll need is one that will act as a simple utility to clear the text fields. The code in this function simple sets the text from the note and title text fields to an empty string. Add the following code starting on line 11:

clearFields = function()
{
  noteField.text = "";
  titleField.text = "";
}
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6. Now we'll create another utility function that opens our message box component by making it visible and setting some properties for the message we want to display. This function will accept three parameters, the message that we want to display, the title we want the message box to have, and the type of icon we want to accompany the message. Add the following code starting on line 17:

openMessageBox = function(msg, title, icon)
{
  mBox._visible = true;
  mbox.setMessage(msg);
  mbox.setTitle(title);
  mbox.setIcon(icon);
}
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7. Now that we can open the message box, we'll also want to be able to close it by adding another simple utility function that just makes the message box component invisible. Add the following code starting on line 25:

closeMessageBox = function()
{
  mBox._visible = false;
}
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8. Our last utility function will validate the input that the user types into the title and note fields. Add the following code starting on line 30:

validateInput = function()
{
  if(titleField.text.length < 1)
  {
    openMessageBox("The Title Field is Required", "Invalid     Input", "error");
    return false;
  }
  if(noteField.text.length < 1)
  {
    openMessageBox("The Note Field is Required", "Invalid     Input", "error");
    return false;
  }
  return true;
}
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Now that we have some basic utility functions for the application, we'll code the functions that are called when a user interacts with any of the components. These are called change handlers. The component change handlers are triggered anytime a user clicks on an active area of the component. We can configure our components (for example, the list box or buttons) to react in any way we want as a result of user interactions.

To create the component change handlers for the application:

1. The first change handler function we'll create will be for the list box and will be triggered anytime the user clicks on an item in the list of notes. Add the following code starting on line 45:

onListBoxSelect = function()
{
  syncFields();
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This function simply calls the utility function we already wrote to sync the text fields with the selected list box item. 

2. The next three change handlers will be for the view, edit/delete, and add buttons of the application and are all similar. Each function moves the play head to the appropriate frame in the timeline. The view button change handler also calls our syncFields utility function to make sure the proper note is displayed. Add the following code started on line 50:

onAddButtonRelease = function()
{
  gotoAndStop("addNote");
}
onEditButtonRelease = function()
{
  gotoAndStop("editNote");
}
onViewButtonRelease = function()
{
  gotoAndStop("viewNote");
  syncFields();
}
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3. The next change handler is for the submit button that is part of the addNote frame in the timeline. Add the following code starting at line 64:

onAddSubmitButtonRelease = function()
{
  if(!validateInput())
  {
    return;
  }
  var params = new Object();
  params.title = titleField.text;
  params.note = noteField.text;
  noteService.addNote(params);
  openMessageBox("Saving Note.", "Saving Note.", "info");
}
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The function first checks to make sure the text field input is valid using our validateInput utility function. If the validateInput function does not return true, the function returns and the user will be left with the error message from our validate. Otherwise the function continues by creating a params object to hold the title and note text and then assigns the contents of those two fields to the title and note properties of the params object. These are the parameters that correspond with the required arguments for our addNote web service function. The addNote web service is then called and the params object is passed out to it with the users imput. Lastly, the message box is opened to tell the user the message is being saved. 

4. Now we need a change handler for the delete button that exist in the editNote frame of the timeline. Add the following code starting on line 77:

onEditDeleteButtonRelease = function()
{
  var id = lb.getSelectedItem().data.id;
  if(id == undefined)
  {
    openMessageBox("You must first select a note to delete.",     "Invalid Input", "error");
    return;
  }
  var params = new Object();
  params.id = id;
  noteService.removeNote(params);
  openMessageBox("Deleting Note.", "Deleting Note.", "info");
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The function starts by creating an id variable and assigning it the id of the note that the user has selecting in the list box. If the users hasn't selected a note then this will end up being undefined and the function will send an error message to the message box and return from the function. Otherwise, the id is assigned to a params object and passed to the removeNote function of our web service, which is used to delete the note from the database. Again, the last thing that happens in the function is the message box is opened with a message for the user. 

5. Our last change handler is called when a user edits an existing note in the editNote frame and clicks the submit button. Add the following code starting on frame 91:

onEditSubmitButtonRelease = function()
{
  if(!validateInput())
  {
    return;
  }
  var params = new Object();
  params.id = lb.getSelectedItem().data.id;
  params.title = titleField.text;
  params.note = noteField.text;
  noteService.updateNote(params);
  openMessageBox("Saving Note.", "Saving Note.", "info");
}
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This is similar to the addNote change handler above. The function first validates the text field input, then create a params object to assign all the input to. It then passes this to the updateNote function of our web service and presents the user with a "Saving Note" message.

Now we're ready to create the functions that will actually process the results of the web services that we're calling. Since these functions are triggered in response to calling a web service, they are sometimes referred to as callback functions. 

To create the results functions for Flash Remoting:

1. First we'll create a new object called result that our NetServices can use to return data to. Add the following code on line 105:

var result = new Object();

Here we are creating an object (named result) to store our Flash Remoting callback functions. Why not just place the functions on the main timeline and return the data to the timeline itself? There are two reasons we place the callback functions in their own object. First, it helps to better organize our code. When you see a method attached to the result object you know automatically that it is a callback function, which keeps the code very clear. The second, and more important reason, is that it places the callback function within its own namespace. This prevents someone else from creating a function on the timeline and accidentally overwriting the existing function. This becomes more likely the more complex an application becomes, and can make debugging an application very difficult. 

2. The first results function we'll create will respond to the addNote web service function. Add the following code starting on line 107:

result.addNote_Result = function(obj)
{
  closeMessageBox();
  openMessageBox("Note Sucesfully Added.", "Sucess", "info");
  clearFields();
  lb.setEnabled(true);
  lb.addItem(obj.title, obj);
  lb.setEnabled(false);
}
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The function first closes the message box (since is it would currently be displaying a "Saving Note" message to the user) and then reopens it with a message to the user that the note was successfully saved. The function then clears the text fields, enables the list box and adds the new note to it, then disables the list box to leave the application in a state to add more notes. 

3. The next results function responds to the removeNote function of the web service. The function takes the note id that the web service returns. Add the following code starting on line 117:

result.removeNote_Result = function(id)
{
  closeMessageBox();
  var len = lb.getLength();
  if(len < 1)
  {
    return;
  }
  for(var i = 0; i < len; i++)
  {
    if(lb.getItemAt(i).data.id == id)
    {
      lb.removeItemAt(i);
      openMessageBox("Note Sucesfully Deleted.", "Sucess",       "info");
      gotoAndStop("viewNote");
      syncFields();
      return;
    }
  }
}

This function first closes the message box (the would currently be open displaying the "Deleting Note" message). It then creates a variable called len and assigns it the length of the list box. If that length is less than 1, then we don't have to do anything and the function just returns. Otherwise we start looping through all the items in the list box looking for the one that matches the id that we just removed. When it finds the correct id using the if statement, it removed the corresponding item from the list box, give the user a message, sends the timeline to the viewNote frame and syncs the text fields. 

4. Now we'll create a results function for the updateNote web service function. Add the following code starting on line 138:

result.updateNote_Result = function(obj)
{
  closeMessageBox();
  var len = lb.getLength();
  if(len < 1)
  {
    return;
  }
  var tempObj;
  for(var i = 0; i < len; i++)
  {
    tempObj = lb.getItemAt(i).data;
    if(tempObj.id == obj.id)
    {
      lb.replaceItemAt(i, obj.title, obj);
      return;
    }
  }
}

The function begins just like the removeNote result function by closing the message box, creating a variable to hold the list box length, and returning if there is nothing in the list box. Then the function creates a temporary object that we'll use to compare the id of notes while looping through them. We loop through the all the notes, each time assigning the data from the note we're currently on to the temporary object. We then check to see if the id matches the one we just updated. If the id matches, we replace the note title in the list box with the updated note title and then the function returns. 

5. Our next result function handles the data the is returned from the getAllNotes function of the web service. Add the following code starting on line 158:

result.getAllNotes_Result = function(rs)
{
  closeMessageBox();
  gotoAndStop("viewNote");
  lb.setEnabled(true);
  var len = rs.getLength();
  if(len < 1)
  {
    return;
  }
  var obj;
  for(var i = 0; i < len; i++)
  {
  obj = rs.getItemAt(i);
  lb.addItem(obj.title, obj);
  }
}

The function closes the message box, sends the play head to the viewNote frame, enabled the list box so we can use it, and creates a variable to hold the length of the record set that the web service returned when it was called. If the length is less than one, there are no note titles to process and the function returns. Otherwise, we create a temporary object that we can use to add the titles to the list box and then start looping through the record set. For every record, the loop assigns the data to the object and then adds it to the list box. 

6. Our last result function doesn't process any data from the web service functions, instead it handles status information about our NetService connection. Add the following code starting on line 176:

result.onStatus = function(info)
{
  closeMessageBox();
  trace("Error : " + info.description);
  openMessageBox(info.description, "Error", "error");
}
_global.System.onStatus = result.onStatus;

This function is called if there is are any errors while communicating with the server. The function simply closes the message box if its open, traces the error description to the output window (this only occurs when testing the movie in Macromedia Flash MX), and then opens the message box with the error description. The last line here isn't part of the function, instead it overwrites the default onStatus function with the custom one we created.

Now that we've created all the functions of handle the data from the server, we'll want to initialize our components and then actually connect to the server and retrieve some data. 

To initialize the application:

1. Start by adding the following code on line 184:

lb.setChangeHandler("onListBoxSelect");
addButton.setChangeHandler("onAddButtonRelease");
editButton.setChangeHandler("onEditButtonRelease");
viewButton.setChangeHandler("onViewButtonRelease");

These four lines just set the change handlers for the four component that are on in the first frame (and all subsequent frames) to the callback functions we defined for them. 

2. Now we'll disable the components so that they can't be clicked until we're sure all the data is loaded by adding the following code on line 189:

viewButton.setEnabled(false);
editButton.setEnabled(false);
addButton.setEnabled(false);
lb.setEnabled(false);
3. We'll also want to make sure the message box starts out invisible by adding the following code to line 194:

mBox._visible = false;
4. Now we'll actually open a connection to the Flash Remoting gateway on the server and request the web service that we created for the application. Add the following code to line 196:

var server = NetServices.createGatewayConnection("http://localhost:8500/flashservices/gateway");
var noteService = server.getService("Notes.note_tutorial", result);

The first line creates the connection to the gateway. The second line creates a noteService object and requests the "Note" service. This is actually just the name of the CFC we created. The note_tutorial.cfc file is in the "notes" folder in the ColdFusion MX web root, so we can access it using dot syntax and the path to the file, in the case notes.Note. The second parameter of the getService method is the object that will receive everything the web service returns, in this case the result object we created. 

5. The last thing we need to do is actually call the getAllNotes web service function to retrieve our list of notes and stop the play head on the first frame while the data loads. Since we now have all the functions from the CFC as web services, we can simply call them as methods of the noteService object we created. Add the following code starting on line 199:

noteService.getAllNotes();
stop();
We're finished with the bulk of the ActionScript that we need. Now we just need to write a few lines of code for each state of our application in the three remaining key frames that serve as our application states.

To set the properties for the application states:

1. With the Actions Panel open, select the frame 10 of the Format Code layer. 

2. This is the viewNote state of the application and we'll want to set certain properties for our text fields and components by adding the following code starting on line 1:

noteField.type = "dynamic";
titleField.type = "dynamic";
lb.setEnabled(true);
addButton.setEnabled(true);
editButton.setEnabled(true);
viewButton.setEnabled(false);
sectionField.text = "View Note";

The actions on this frame change the components, type of text fields, and the sectionField text to indicate that the user is in the View Note state of the application. The first two lines set the note and title text fields to dynamic so that the user cannot change the text. The next four lines enable the list box, add, and edit button, and disable the view button since the user is already in the view section. The last line changes the text for the sectionField text field to show the user the section they are in. 

3. With the Actions Panel open, select the frame 20 of the Format Code layer. 

4. This is the editNote state of the application. Again we'll set some properties of the application state by adding the following code starting on line 1:

noteField.type = "input";
titleField.type = "input";
lb.setEnabled(true);
addButton.setEnabled(true);
editButton.setEnabled(false);
viewButton.setEnabled(true);
sectionField.text = "Edit Note";
editDeleteButton.setChangeHandler("onEditDeleteButtonRelease");
editSubmitButton.setChangeHandler("onEditSubmitButtonRelease");

The actions in this frame start by changing the note and text fields to input text fields to allow the user to modify the text. The component properties are modified so that they are all enabled except for the edit button and the display text is set to indicate the application state. The last two lines set the change handlers for the Delete and Submit buttons. We were able to set these in frame 1 on the Actions layer with the rest of the component change handlers because these two button components did not yet exist in the timeline. 

5. With the Actions Panel open, select the frame 30 of the Format Code layer. 

6. This is the addNote state of the application. This is the last state we have in our application and we'll set its properties by adding the following code starting on line 1:

noteField.type = "input";
titleField.type = "input";
lb.setEnabled(false);
addButton.setEnabled(false);
editButton.setEnabled(true);
viewButton.setEnabled(true);
sectionField.text = "Add Note";
clearFields();
submitButton.setChangeHandler("onAddSubmitButtonRelease");

The properties for this application state are much like that of the editNote application state except in this state we want to clear the text fields first so that the user can enter new text to add a note. The last line sets the change handler for the Submit button so that the onAddSubmitButtonRelease function we created will be called when the user submits the new note. 

7. Now that we've got all the code in place, the last thing we'll want to do is save the file (File > Save) and publish the SWF and HTML to run the application (File > Publish). This will create two files in the server where the noteboard_tutorial.fla file is saved. The first file, noteboard_tutorial.swf, is the actual Macromedia Flash file that makes up our application. The second file, noteboard_tutorial.html, is the HTML wrapper that we use to browse to the application. 

We're now finished coding the client-side portion of our Rich Internet Application. We've set up some utility functions to perform basic operations within the application, coded the change handlers for the components, created the results functions to handle incoming and outgoing data, made the connection to the application server, and set all the properties for each of our application states.

We now have a fully functional, collaborative note-taking application. If you browse to the URL http://localhost:8500/Notes/noteboard_tutorial.html on the local ColdFusion MX installation, you should be able to see the note-taking application and view, edit, and add notes. If you have problems getting any part of the application to work, try checking your code against the completed files in the Notes folder.

Lastly, The Note Board application was kept as simple as possible. Inevitably, some application functionality was sacrificed for simplicity. Here are a few improvements that might have been part of a more complex or complete application that you can implement on your own if you'd like:




















































